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1 Introduction 
 
 
 
This manual is for the Media Reactor Version 2.00 software from Drastic Technologies Ltd.  
 
Please review the Installation Guide before installing the software. This guide provides instructions on 
how to install the software.  There is also information on specific configuration issues.  In addition, the 
authorization procedure is covered in detail. 
 
The Quick Start section of this manual is provided to give a brief overview as well as a tutorial on using 
the software so you may get started right away. 
 
The User’s Guide provides in-depth information about the operation of MediaReactor.  
 
The Reference section provides information on the individual components of the user interface and the 
media data files that MediaReactor can process. 
 
The Glossary section provides definitions for certain technical terms used within this manual. 
 
Document Conventions 
 
The following conventions are used throughout this manual: 
 
Type Style Used For 
Bold Bold is used for a label on a control in the 

interface.  
Italic Italic is used for a term defined in the manual or 

the glossary. 
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2 Installation Guide 
 
 
 
Please insure the systems you wish to install the MediaReactor software on meet the minimum 
requirements. If you are setting up MediaReactor to be run as a standalone application on a workstation 
use the step by step instructions for local installation. If you wish to use MediaReactor with a network 
licensing option refer to the section on network installation. 

2.1 Requirements 
 
MediaReactor runs on industry standard Pentium/Xeon class single or multiprocessor workstations and 
servers. 
 
Operating Systems: 
 
Microsoft Windows NT/2000/XP WorkStation or Server 
 
Hardware: 
 
Minimum recommended station – Pentium III 600 MHz, 256MB of RAM 
 
Optimum – Dual Pentium Xeon 3.02GHz or higher with 1GB of RAM 
 
Notes: 
 

1. The performance of MediaReactor’s transcoding engine is primarily dependent upon the 
bandwidth of its storage access. The best performance will be attained when using the highest 
possible bandwidth to read and write the media. 

2. MediaReactor needs to be run on a server version of the operating system if access is required to 
Apple or SGI systems and the domain controller is not a Windows server. 

2.2 Local Installation 
 
The installation process involves two phases, first the MediaReactor software is installed and then 
MediaReactor must be authorized. You may also have to install third party software either required by 
MediaReactor or to extend its functionality. 
 
After checking the computer is configured according to the minimum system requirements make sure that 
you are logged in as a user with administrative privileges. Remove the MediaReactor software CD from 
its packaging.   
 
1. Place the MediaReactor software CD in the CD-ROM drive.   
2. The software will automatically begin the install procedure. If it doesn’t, go to your CD-ROM drive 

and open the SetupMR.exe program.  The installation will begin. 
3. You will be prompted at each step of the install, and by pressing the ‘Next’ or ‘Finish’ button you 

can complete the installation procedure. Carefully read the instructions that are provided. 
4. The initial dialogs will confirm your license agreement, installation folder and desktop shortcut. You 

will now begin the component installation and configuration. 
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5. You will be prompted to ‘Choose a License Server’. Since this is a local installation leave the Local 
button selected and press ‘Next’. 

6. You will be prompted to choose a video ‘Standard’. This will set the default video format when you 
are from a series of still image files. (This may be changed after installation through the Edit|Options 
menu. 

7. When the installation process is complete you will need to restart the system. 
 
Apple’s QuickTime software must be installed before MediaReactor can be installed on your system. The 
option to install QuickTime is available to you from the installation menu. Windows Media Encoder is 
the other available option. It is installed to allow you to create and edit profiles. 
 
The Third Party folder on the CD contains setups for media players, encoders and operating system 
components you may require. 

2.2.1 Authorization 
 

MediaReactor uses a software based copy protection system. You will not have to install any additional 
hardware on your computer in order to run MediaReactor. There are however some issues you need to be 
aware of when working with MediaReactor and its copy protection system. 
 
When you first install MediaReactor it will be unauthorized and only operate with limited translation 
features.  You will need to authorize your MediaReactor software in order to enable other translations. 
 
To authorize your MediaReactor you will need to provide Drastic Technologies with a Site Code after 
which you will receive the Site Key to set your authorization. The licensing functions of MediaReactor 
are all found on the Edit|License selection of the menu bar.  The software protection uses the system 
clock so make sure it is properly set. 
 
In order to authorize your copy of MediaReactor select License Authorization from the License menu. 
This will open the Drastic Technologies Authorization window. 
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The top of the window provides a summary of your license status. The Authorization section of the 
window is where you will obtain the Site Code and input your Site Key. Due to its length we recommend 
you select the whole site code with your mouse and use the copy function (Ctrl-C) to put it in the 
clipboard. Paste the Site Code into an email message (Ctrl-V) and send it to Drastic Technologies at: 
authorization@drastictech.com.  Please specify the software you wish to authorize. 
 
You will receive a reply from us containing your Site Key. We will attempt to respond as quickly as 
possible but be sure to give yourself a good time margin in requesting your authorization code. Drastic 
Technologies Ltd. offices are located in the Eastern Standard Time zone of North America and we will 
only be able to provide you with a code during regular business hours (Monday to Friday, 9am to 5pm). 
 
Once you have received the reply with the Site Key select it and copy it to the clipboard. Open 
MediaReactor and go to the Authorization section of Drastic Technologies Authorization window. 
Paste the Site Key into its box and push the Click to update your license button.  Your license will then 
be updated. 
 
MediaReactor must be restarted in order for the authorization to take effect. 

2.3 Network Installation 
 
MediaReactor may be installed to run in a network license environment. This lets your facility access 
MediaReactor from any workstation attached to the network without having to purchase a separate license 
for each one. 
 
One computer in the network is designated as the license server and it is this server which provides the 
authorization required to run MediaReactor to all the other client workstations. The server holds the 
number of licenses you have been authorized to run and distributes them to the client workstations as they 
are requested. When a client runs MediaReactor a license request is made to the server and if a license is 
available the client runs as a licensed copy of MediaReactor. When you exit from MediaReactor on the 
client its license is returned to the server and becomes available for use by another workstation. 
 
To install MediaReactor for network license operation you must first install the license server. 

2.3.1 Server Installation 
 
In order to make a network license server you must install MediaReactor on the workstation or server 
which you have designated as the license server. The folder you install MediaReactor in must be 
accessible to all the other workstations in your network that you wish to run MediaReactor on. If you are 
not sure how to do this please contact to your network administrator. (Note: MediaReactor must be 
installed on a local drive. The licensing will not function if you attempt to install it on a remote drive.) 
 
The installation process involves two phases, first the MediaReactor software is installed and then 
MediaReactor must be authorized. You may also have to install third party software either required by 
MediaReactor or to extend its functionality. 
 
After checking the computer is configured according to the minimum system requirements make sure that 
you are logged in as a user with administrative privileges. Remove the MediaReactor software CD from 
its packaging.   
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1. Place the MediaReactor software CD in the CD-ROM drive.   
2. The software will automatically begin the install procedure. If it doesn’t, go to your CD-ROM 

drive and open the SetupMR.exe program.  The installation will begin. 
3. You will be prompted at each step of the install, and by pressing the ‘Next’ or ‘Finish’ button 

you can complete the installation procedure. Carefully read the instructions that are provided. 
4. The initial dialogs will confirm your license agreement, installation folder and desktop shortcut. 

You will now begin the component installation and configuration. 
5. You will be prompted to ‘Choose a License Server’. Since this is the server installation you 

leave the Local button selected and press ‘Next’. 
6. You will be prompted to choose a video ‘Standard’. This will set the default video format when 

you are from a series of still image files. (This may be changed after installation through the 
Edit|Options menu. 

7. When the installation process is complete you will need to restart the system. 
 
Apple’s QuickTime software must be installed before MediaReactor can be installed on your system. The 
option to install QuickTime is available to you from the installation menu. Windows Media Encoder is 
the other available option. It is installed to allow you to create and edit profiles. 
 
The Third Party folder on the CD contains setups for media players, encoders and operating system 
components you may require. 

2.3.2 Server Authorization 
 

MediaReactor uses a software based copy protection system. You will not have to install any additional 
hardware on your computer in order to run MediaReactor. There are however some issues you need to be 
aware of when working with MediaReactor and its copy protection system. 
 
When you first install MediaReactor it will be unauthorized and only operate with limited translation 
features.  You will need to authorize your MediaReactor software in order to enable the translation 
features you have purchased. 
 
To authorize your MediaReactor you will need to provide Drastic Technologies with a Site Code after 
which you will receive the Site Key to set your authorization. The licensing functions of MediaReactor 
are all found on the License selection of the menu bar.  The software protection uses the system clock so 
make sure it is properly set. 
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The top of the window provides a summary of your license status. The Authorization section of the 
window is where you will obtain the Site Code and input your Site Key. Due to its length we recommend 
you select the whole site code with your mouse and use the copy function (Ctrl-C) to put it in the 
clipboard. Paste the Site Code into an email message (Ctrl-V) and send it to Drastic Technologies at: 
authorization@drastictech.com.  Please specify the software options and the number of licenses you wish to 
authorize. 
 
You will receive a reply from us containing your Site Key. We will attempt to respond as quickly as 
possible but be sure to give yourself a good time margin in requesting your authorization code. Drastic 
Technologies Ltd. offices are located in the Eastern Standard Time zone of North America and we will 
only be able to provide you with a code during regular business hours (Monday to Friday, 9am to 5pm). 
 
Once you have received the reply with the Site Key select it and copy it to the clipboard. Open 
MediaReactor and go to the Authorization section of Drastic Technologies Authorization window. 
Paste the Site Key into its box and push the Click to update your license button.  Your license will then 
be updated.  The Drastic Technologies Authorization window will close, and the Status window will 
open to display your new status. 
 
This status varies depending on what you have been licensed for. 

2.3.3 Client Installation 
 
The Client installation does not require an authorization step because it gets its authorization from the 
network license server. 
 
After checking the computer is configured according to the minimum system requirements make sure that 
you are logged in as a user with administrative privileges. Remove the MediaReactor software CD from 
its packaging.   

 
1. Place the MediaReactor software CD in the CD-ROM drive.   
2. The software will automatically begin the install procedure. If it doesn’t, go to your CD-ROM 

drive and open the SetupMR.exe program.  The installation will begin. 
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3. You will be prompted at each step of the install, and by pressing the ‘Next’ or ‘Finish’ button 
you can complete the installation procedure. Carefully read the instructions that are provided. 

4. The initial dialogs will confirm your license agreement, installation folder and desktop shortcut. 
You will now begin the component installation and configuration. 

5. You will be prompted to ‘Choose a License Server’. Since this is the client installation you must 
select the Network option button. The selector for ‘Network License Location’ will appear. Use 
the Browse button to locate the license server’s MediaReactor folder and select it. 

6. You will be prompted to choose a video ‘Standard’. This will set the default video format when 
you are from a series of still image files. (This may be changed after installation through the 
Edit|Options menu. 

7. When the installation process is complete you will need to restart the system. 
 
Apple’s QuickTime software must be installed before MediaReactor can be installed on your system. The 
option to install QuickTime is available to you from the installation menu. Windows Media Encoder is 
the other available option. It is installed to allow you to create and edit profiles. 
 
The Third Party folder on the CD contains setups for media players, encoders and operating system 
components you may require. 
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2.4 Other License Options 
 
The License menu also provides you with the following options: You may Transfer your license to a 
location on your network, or to a floppy for installation into a system which is not on your attached 
network.  You may View the status of your license.  You may also Destroy the license and revert to the 
free version of MediaReactor.  These options are covered in detail in the User’s Guide later in this 
document. 
 

 
 

 
 

 

2.5 Technical Issues 
 
There are some technical issues you need to be aware of so you will not damage your license or cause 
your license to fail. 
 
Disk Failure After replacing the drive and reinstalling the software contact Drastic to 

get reauthorized. Please explain the situation in your request. 
Clock Change Changing the clock will be detected and cause your license to fail 
Disk compression or de-
fragmentation software. 

Using a de-fragmentation program like Norton Speed Disk can damage 
your license. If you wish to use one of these programs make sure you 
configure them not to move any *.ent, *.rst and *.key files. 
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3 Quick Start 
 
 
What is MediaReactor? 
 
MediaReactor is a transcoder that can translate between a number of video, audio and still image digital 
media formats.   It takes an existing digital media file and makes a copy of it. During the copying process 
MediaReactor can change the file type, compression format and other parameters of the source file. 
MediaReactor supports file formats that are used by digital disk recorders, non-linear editors as well as 
compositing, effects and animation software. When the computer running MediaReactor is networked to 
other workstations or dedicated devices then the translations may be performed seamlessly between them. 
 

3.1 Navigating the Graphical User Interface 
 
The GUI (Graphical User Interface) of the MediaReactor is straightforward, and we will describe its 
operation in detail as we go through this section.  There are a number of settings to be adjusted before 
files can be converted.   The steps to adjust these settings are defined in the following tutorial.   Here is an 
example of what the MediaReactor interface looks like. 
 
As illustrated in the diagram the interface is made up of a number of components. 
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In this view, we see the following windows open in the MediaReactor interface: the Source Browser, the 
Session Browser, the Target Settings and the Output Window. 
 
In the Quick Start section of this manual, we will take the user quickly through a sample conversion.  For 
a more detailed look at the conversion process, please view the User’s Guide section of this manual.
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3.2 Performing a Media Conversion 
 
This tutorial will demonstrate how to transcode a media file.  This process consists of selecting source 
file, setting the target parameters (including the target filename and location) then running the conversion. 
 

1. Open a New Session from the Main Menus, under File/Session/New.  
 

2. The Session window opens up between the Source Bowser and the Session Browser.  The first 
thing to do is select a Source file.  To find a file you have stored either on local or 
attached/networked storage select the Browse button to the right of the box titled “Source File:”.  
This opens up a standard Windows “Open” dialogue box.  You will select a source file from 
within this box. 

 
3. Double clicking on a drive will show all the folders on it and double clicking on a folder will 

show all the folders within this directory, and so on through the sub-folders.  Navigate through 
your storage for the file you want to convert.  Double-click on an appropriate file or select Open 
to load it into the Source File field of the Session menu. 

 
4. Once the source file has been selected, you may enter a new name for the target file (the file you 

are going to create during the conversion process).  Highlight the words “Enter a target name” 
in the Session dialog box with your mouse and enter a new name using your keyboard. 

 
5. You now need to determine where you want the file to be created.  Select the Browse button 

under the “Target File” title.  This will open a standard Windows “Browse for Folder” dialog 
box.  (You may find it is handy to create a dedicated folder in the directory of your choice prior to 
pressing the Browse button to select a target folder.)   

 
6. The remaining series of steps will be to set the file parameters.  Confirm that the Target Settings 

window is open.  If it is not, use the View menu to select it.  The Target Settings window is the 
dialog box you will use to set the conversion parameters of the new file you will create. 

 
7. Confirm that the File Settings tab near the bottom of the Target Settings window is selected.  

When selected, the tab will be blue.  You may now set the following parameters of the target file 
(the file you are going to create): 

? Target Folder Set the location of the newly created file.  You may have 
already set this location in the Session window, but you may adjust it here if 
needed. 

? File Type Select a file type.  The available file types offered here depends 
on the version of MediaReactor you are using. 

? Codec Type Compression/Decompression format.  Dependent on the file 
type. 

? Height This field sets the height in pixels of the translated image.  
? Width This field sets the width in pixels of the translated image.  
? Bit Depth This field sets the number of bits per pixel that controls the color 

resolution of the translated image. 
? Quality This field sets the quality factor of the compression scheme of 

the translated image data.  
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? Data Rate This field sets a target data rate for the compression scheme of 
the translated image data. 

? Key Frame Set the interval between key frames for the codec of the target 
file here. 

? Audio Type Unless you choose Separate Audio, an audio file will be 
generated in the conversion process that is compatible with the video file type 
you have selected.  If you are creating a separate audio and video file, you will 
then be able to select an audio file type different than that used by the file type 
chosen.  As well, several of the below choices become active: 

? Compression Select the level of compression to be applied to the 
separate audio file.  This only becomes active when the user has selected 
Separate Audio. 

? Sample Rate Set the Sample Rate applied to the separate audio file.   
This only becomes active when the user has selected Separate Audio.  

? Bits/Sample Set the Bits per Sample ratio of the separate audio file.  This only 
becomes active when the user has selected Separate Audio.  

? Separate Audio Select this to create separate audio and video files from a 
file that contains audio and video (or a series of still images). Some systems 
require their audio source material to be in another file. Check in the 
compatibility section for information about these systems. 

? Audio Only Select this checkbox to prevent the creation of a new video file 
during this conversion.  This only becomes active when the user has selected 
Separate Audio. 

? Dual Mono Select this checkbox to create two “mono” audio files (using the 
audio from the source video file) in addition to the source video file.  This 
only becomes active when the user has selected Separate Audio.   

 
8. The Target Settings window – Process Tab offers certain advanced file processing features and 

adjustments not present on the File Settings tab.  To access these features, confirm that the 
Process tab near the bottom of the Target Settings window is selected.  When selected, the tab 
will be blue.  You will then be able to set the following parameters: 

 
? Add Process This check box enables the processing and allows you to select 

the type of processing from the pulldown menu. 
? Process Type Use this pulldown menu to select between the available 

processes.  Choices here include: Blend Fields, De-interlace Blend, De-interlace 
Interpolate, Duplicate Field 1, Duplicate Field 2, Flip Horizontal, Flip Vertical, 
and Invert Fields. 

? Edge This field sets an edge value for the de-interlace processing. The edge 
value controls the detection of intra-field artifacts as opposed to actual high 
frequency content in the image. The greater the value of the edge setting the more 
likely an edge in the image will be blended.  The default value should be adequate 
for most processing but if you need to adjust it do so carefully. 

? P3 This feature is not implemented in this version of MediaReactor. 
? Thres (Threshold) This field sets a threshold value for the de-interlace 

processing. The threshold value controls the detection of the intra-field motion of 
an object. The greater the motion of an object between fields the higher the 
threshold needs to be set so it will be detected and used in the blending process.  
The default value should be adequate for most processing but if you need to adjust 
it do so carefully. 
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? 2/3 Drop Select this checkbox to implement the conversion to and from 
film rate.  The Add, Remove, and A Frame fields set the parameters of this 
conversion to and from film rate.   

? Add Select Add if you have a film rate file (24 fps) and you need to “Add” 
frames to convert this file to NTSC or PAL frame rate. 

? Remove Select this checkbox if you have an NTSC or PAL file generated on a 
Telecine and you need to remove the “inserted” frames to end up with a 24 fps 
file. 

? A Frame The “A Frame” represents the first frame after the inserted video 
frame generated by a Telecine.  Setting the A Frame involves stepping though the 
file by frames to find the first “jittery” frame.  This will be the first frame 
generated by the Telecine.  Step forward one frame and note this location by time 
code. Enter this value into the “A Frame” field.  This synchronizes the addition or 
removal of all of the inserted frames, as they occur at predictable intervals. 

 
9. Click on the Convert Sessions button at the bottom of the Target Settings window.    Alternately, 

you may select the “Go” button on the toolbar.   
 

10. Selecting this button opens the Translation Setup window, offering you a choice of which 
session to convert.  In our Quick Start example, we have set up one conversion.  Select this 
conversion by checking the checkbox to the left of the session name with your mouse. 

 
11. Press the Convert button.  MediaReactor will begin to convert the file.  The Translation Setup 

window will display the conversion parameters you have created, as well as the progress of the 
conversion. 

 
12. Note the conversion progress bars on the Translation Settings window.  There is a bar for the 

progress of the current session, and a bar for the progress of all of the sessions selected for 
conversion.  Clicking on the “Abort” button with the mouse, or pressing Enter on the keyboard 
during the conversion will cancel the conversion process at this point. 
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4 User’s Guide 
 
 
 
The User’s Guide will first introduce the general concepts you need to understand in order to use the 
MediaReactor software.  
 
The next section takes a task-based approach to understanding MediaReactor and provides a step by step 
description on performing the types of conversions that can be done with the program. 
 
The last sections of this guide provide detailed information about the translation process and techniques 
for enhancing the workflow. 

4.1 General Concepts 
 
MediaReactor is a tool for file processing. It works with source files that contain video, audio or still 
image data and creates a copy of the media contained within them to a target file of any of the file types 
or formats supported by MediaReactor. The steps involved are: 
 
? Selecting the source material to be converted 
? Setting the parameters of the target file 
? Specifying the location of the target file 
? Naming and saving the session and workplace if required 
 
All of this information defines a translation Session. It is this session information that controls the 
translation process. Once a Session is defined it can be run, saved to disk or be retrieved to run at a later 
date. 
 
MediaReactor allows you to work with more than one Session at a time. Sessions are contained in a 
Workspace. The Workspace allows you to create a group of translation Sessions, save or retrieve them and 
run them as a batch process. 

4.2 Performing Conversions 
 
This section will provide a step by step description of performing each of the conversion options that 
MediaReactor supports. 

4.2.1 Video to Video (“Full”) Conversion 
 
This tutorial will demonstrate how to perform a Full conversion.  This process consists of selecting a 
media file containing both video and audio from local or network storage, converting it to another format 
with all its video and audio intact, saving it to either local or network storage. 
 
The next few steps will take us through this conversion.  Open a New Session from the Main Menus, 
under File/Session/New.  
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The above window opens up between the Source Bowser and the Session Browser.  The first thing to do 
is select a Source file.  To find a file you have stored either on local or attached/networked storage select 
the Browse button to the right of the box titled “Source File:”.  This opens up a standard Windows 
browser: 
 

 
 
The Open dialog box will allow you to browse either the local or any networked storage that has been 
mapped to the computer.  The network mapping should be set up during installation so the operator will 
be able to find the necessary material and access it for the conversion. Refer to your system administrator 
for setting up the network.  Select a media file by double-clicking on it with your mouse, or select the file 
and press Open. 
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The Source Browser window shows any storage attached to the computer, either fixed or removable 
media, or network storage that has been mapped to local drive letter or the Network Neighborhood.  Any 
media files selected in the Source Browser window will be loaded into the Source File field of the 
Session. 
 
Once the source file has been selected, you may enter a new name for the target file (the file you are 
going to create during the conversion process). 
 

 
 
Highlight the words “Enter a target name” with your mouse and enter a new name using your keyboard. 
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Target Video 
 
You now need to set the target location for your new file.  Browse through your storage for an 
appropriate location in which you want your newly created file to reside.  Select the Browse button under 
the “Target File” title.  This will open the following “Browse for Folder” dialog box: 
 

 
 

You may find it is handy to create a folder in the directory of your choice prior to engaging the Browse 
button to select a target folder.  
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Target Settings 
 
The remaining and most important series of steps will be to set the parameters of the file(s) you are going 
to create.  Confirm that the Target Settings window is open.  If it is not, use the View menu to select it. 
 

 
Target Settings window 

 
Target Settings window – File Settings Tab 
 
Confirm that the File Settings tab near the bottom of the Target Settings window is selected.  When 
selected, the tab will be blue.  The parameters of the file you are going to create may be set in this dialog 
box. 
 

? Target Folder The Target Folder pulldown menu will display the location selected in the 
Session Manager window. You may have already set the location in the Session window, but you 
may adjust it here if needed.  Select the “down” arrow at the right side of this menu to reveal the 
network tree for navigation. 

? File Type The File Type pulldown menu allows the user to select the target file type.  
Depending on which file type you select in this field, you will see different choices offered in the 
subsequent fields.  The file types displayed in this menu depend on which level of MediaReactor 
you have installed.  Select the “down” arrow at the right side of this menu to reveal the file types. 

? Codec Type Translate the source media to this compression / decompression (codec) format. 
This field will give you a drop-down menu of the available codecs. This list will include the 
codecs built into MediaReactor as well as any other codecs installed on the workstation. Select 
the “down” arrow at the right side of this menu to reveal the available choices.  Select from this 
list. 
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? Height  This field sets the height in pixels of the translated image. Some file types and 
codec formats may impose these limitations:  

? a specific vertical size  
? a minimum vertical size.  
? a maximum vertical size.  
? a vertical size that is a multiple of a particular step size.   

Edit the Height field to change the value and MediaReactor will accept the change if it is 
supported or substitute the closest value otherwise.  For file types with adjustable sizing, the “up” 
and “down” arrows increment in steps representing available height choices. 

? Width  This field sets the width in pixels of the translated image. Some file types and 
codec formats may impose these limitations: 

? a specific horizontal size  
? a minimum horizontal size.  
? a maximum horizontal size.  
? a horizontal size that is a multiple of a particular step size.   

Edit the Width field to change the value and MediaReactor will accept the change if it is 
supported or substitute the closest value otherwise.  For file types with adjustable sizing, the “up” 
and “down” arrows increment in steps representing available width choices. 

? Bit Depth This field sets the number of bits per pixel that controls the color resolution of 
the translated image. Some file types and codec formats may impose limitations on this setting. 
Edit the Bits field to change the value and MediaReactor will accept the change if it is supported 
or substitute the closest value otherwise. You can also use the up/down arrow buttons to select the 
from the available bit depths. 

? Quality  This field sets the quality factor of the compression scheme of the translated 
image data. Some file types and codec formats will support this setting. If it is supported 
MediaReactor will allow you to edit the Quality field to change the value.   For file types with 
adjustable quality, the “up” and “down” arrows increment in steps representing available choices. 

? Data Rate This field sets a target data rate for the compression scheme of the translated 
image data. Some file types and codec formats will support this setting. If it is supported 
MediaReactor will allow you to edit the Data Rate field to change the value. This value is 
expressed as Kilobytes per Second.  For file types with adjustable data rates, the “up” and “down” 
arrows increment in steps representing available choices. 

? Key Frame This field sets the interval between key frames for the codec of the translated 
image data. Some file types and codec formats will support this setting. If it is supported 
MediaReactor will allow you to edit the Key Frame field to change the value. This value is 
expressed as a number of frames.  For file types with adjustable key frame intervals, the “up” and 
“down” arrows increment in one frame steps. 

? Audio Type The Audio Type pulldown menu becomes available when the user selects 
“Separate Audio”.  Select the type of audio file you wish to create using the pulldown menu.  The 
audio file type choices available depend on the version of MediaReactor you have. 

? Compression Select the level of compression to be applied to the separate audio file.  This only 
becomes active when the user has selected Separate Audio.  Note that some audio file type 
choices will not offer adjustable compression. 

? Sample Rate The Sample Rate applied to the target audio is displayed here.   This only 
becomes active when the user has selected Separate Audio.  Note that some audio file type 
choices will not offer adjustable sample rates. 

? Bits/Sample The Bits per Sample ratio of the target audio file is set here.   Note that some 
audio file type choices will not allow the user to adjust the bits per sample ratio. 

? Separate Audio Select this to create separate files from a file that contains audio and 
video, one file for video (or series of still images) and one or more files for audio. Some systems 



 

Drastic Technologies Ltd.   20 

require their audio source material to be in another file. Check in the compatibility section for 
information about these systems. 

? Audio Only Select this checkbox to prevent the creation of a new video file during this 
conversion.  This only becomes active when the user has selected Separate Audio. 

? Dual Mono Select this checkbox to create two “mono” audio files (using the audio from the 
source video file) not associated with the source video file.  Some systems require their audio 
source material to be in another file. Check in the compatibility section for information about 
these systems.  This only becomes active when the user has selected Separate Audio. 

 
Target Settings window – Add Process tab 
 

 
Target Settings window – Process tab 

 
Target Settings window – Process Tab 
 
The Process Tab offers certain advanced file processing features and adjustments not present on the File 
Settings tab. 
 
To access these features, confirm that the Process tab near the bottom of the Target Settings window is 
selected.  When selected, the tab will be blue. 
 

? Add Process This check box enables the processing and allows you to select the type of 
processing from the pulldown menu. 

? Process Type Use this pulldown menu to select between the available processes.  Choices here 
include: Blend Fields, De-interlace Blend, De-interlace Interpolate, Duplicate Field 1, Duplicate 
Field 2, Flip Horizontal, Flip Vertical, and Invert Fields. 

? Edge This field sets an edge value for the de-interlace processing. The edge value controls the 
detection of intra-field artifacts as opposed to actual high frequency content in the image. The 
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greater the value of the edge setting the more likely an edge in the image will be blended.  The 
default value should be adequate for most processing but if you need to adjust it do so carefully. 

? P3 This feature is not implemented in this version of MediaReactor. 
? Thres (Threshold) This field sets a threshold value for the de-interlace processing. The 

threshold value controls the detection of the intra-field motion of an object. The greater the 
motion of an object between fields the higher the threshold needs to be set so it will be detected 
and used in the blending process.  The default value should be adequate for most processing but if 
you need to adjust it do so carefully. 

? 2/3 Drop Select this checkbox to implement the conversion between film rate and NTSC 
video.  The Add, Remove, and A Frame fields set the parameters of this conversion.  

? Add Select Add if you have a film rate file (24 fps) and you need to “Add” frames to convert 
this file to NTSC frame rate. 

? Remove Select this checkbox if you have an NTSC file generated on a Telecine and you 
need to remove the “inserted” frames to end up with a 24 fps file. 

? A Frame The “A Frame” represents the first frame of inserted video generated by the 
Telecine.  Setting the A Frame involves stepping though the file by frames to find the first 
“jittery” frame.  This will be the first frame generated by the Telecine.  Note its location by time 
code and enter this value into the “A Frame” field.  This synchronizes the addition or removal of 
all of the inserted frames, as they occur at predictable intervals. 

 
Perform the Conversion 
 
Once you have addressed the above considerations the conversion may be started.  This indicates that you 
have selected the file you are starting with, what type of file it will become, and where the file will be 
created/stored.  Once you have set all the above parameters, performing this conversion is as easy as 
clicking on the Convert Sessions button at the bottom of the Target Settings window.  You may also use 
the “Go” button on the toolbar to perform the conversion. 
 

 
 
This opens the Translation Setup window, offering you a choice between the currently active sessions.  
Select the session or sessions you wish to perform at this time.  Note that the session will have a default 
name (such as MR Session 3) unless you have saved it. 
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Once you select a session or sessions for conversion and press the Convert button, the Translation 
Setup window will display the conversion parameters you have created, as well as the progress of the 
conversion. 
 

 
 
The above diagram shows the conversion progress bars.  There is a bar for the progress of the current 
session, and a bar for the progress of all of the sessions selected for conversion.  Note too that this menu 
contains an Abort button.  Clicking on this button with the mouse, or pressing Enter on the keyboard 
during the conversion will cancel the process at this point. 
 

4.2.2 Insert Audio Conversion 
 
 

 
 
MediaReactor allows the user to add audio to a video file or replace the existing audio with audio of their 
choice.    
 
In a New Session, select a video file either with no audio, or with audio which you will replace.  
Determine the target location and rename the file at this time. 
 
Select the “Insert Audio” option by checking the checkbox titled Insert Audio on the Session window.  
This will add audio to a video-only file, or replace the audio in an existing file.   
 
Select the Browse button just to the right of the Insert Audio checkbox to search through your storage for 
an audio file.  Once you have selected an audio file, it will be displayed in the field to the right of the 
Insert Audio checkbox.  Confirm that all of your other adjustments are correct, and begin the conversion. 
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4.2.3 Audio File-only Conversion 
 
This option will take an existing audio file and create an audio file of another type.  This is like any of the 
other conversions insofar as a few certain steps must be taken in order to perform the conversion.  These 
steps are as follows: 
 

? Select an appropriate source audio file by browsing either in the Session window or the Session 
Browser window.  Loading this into the Source File field of the Session window will grey out 
the (video) file type and codec fields of the Target Settings window, making them un-selectable.  
At the same time, the audio settings will now be selectable, allowing the user to determine which 
type of audio file they are going to create. 

? Select the target folder.  This may be set either in the Session window or the Target Settings 
window. 

? Select the type of audio file to convert the source to. 
? Rename the file if necessary. 
? Perform the conversion. 

4.2.4 Inhibit Video Conversion 
MediaReactor can be used to create an audio-only file from a file containing video and audio.  This means 
that the new file will be audio-only, in a format selected by the user, and a new video file will not be 
created during the process. 
 
Select New Session.  Choose a file containing both video and audio as your Source file.  Name the new 
file.  Select a location in which to save the file.  On the Target Settings dialog box, select Separate 
Audio.  Then select Audio Only.  Now set the audio type, compression, sample rate and bits per sample 
parameters of the target audio file if necessary. 
 
This will create an audio-only file of your choice in the location you have specified.  Go ahead and 
Convert. 

4.2.5 Streaming and De-streaming 
 
MediaReactor can be used to create a series of serialized still images from a source video file.  This 
means that the new image files will be named according to an ascending numerical order. MediaReactor 
uses each frame to create one still image. The number of files that will be created depends on the length 
of the video.  One second of NTSC video will create thirty files.   
 
MediaReactor can also be used to create a source video file from a series of still images.   In order to 
select the entire series of still images, find the first one in the series and select it.  MediaReactor will “see” 
the rest of the files based on the recursive file names. 

4.2.5.1 De-streaming files 
This process converts a video file (a stream of video) to a series of sequenced still images. 

 
? Select an appropriate source file (in this case, a video stream file). 
? Select the target location.  It may be useful at this time to create a folder exclusively for the group 

of still image files you want to create. 
? Select the type of still image file to convert the source to and set any other parameters you wish to 

adjust at this time. 
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? Rename the file if necessary. 
? Perform the conversion.  You should see a series of still image files whose default file names 

appear in ascending numerical order in your storage. 

4.2.5.2 Re-streaming files 
This process converts a still image file type to a different still image file type.  

 
? Select an appropriate source file (in this case, a series of sequenced still images).  In order to 

select the entire series of still images, find the first one in the series and select it.  MediaReactor 
will “see” the rest of the files based on the recursive file names. 

? Select the target location.  It may be useful at this time to create a folder exclusively for the group 
of still image files you want to create. 

? Select the type of still image file to convert the source to and set any other parameters you wish to 
adjust at this time. 

? Rename the file if necessary. 
? Perform the conversion.  You should see a series of still image files whose default file names 

appear in ascending numerical order in your storage. 

4.2.5.3 Streaming files 
 
The process of streaming, or converting a series of stills into a streaming video file, is accomplished in the 
following manner:  In the Source Video window, browse to locate the series of stills.  
 

? Select an appropriate source file (in this case, a series of sequenced still images).  In order to 
select the entire series of still images, find the first one in the series and select it.  MediaReactor 
will “see” the rest of the files based on the recursive file names. 

? Select the target location.  It may be useful at this time to create a folder exclusively for the group 
of still image files you want to create. 

? Select the type of video stream file to convert the source to and set any other parameters you wish 
to adjust at this time. 

? Rename the file if necessary. 
? Perform the conversion. 

 

4.2.6 Convert a Portion of a File 
 

You may not need to convert the entire file you have selected.  If you wish to convert a portion of 
the file you have selected for conversion, please view the file length parameters on the bottom of 
the Session Browser window. 
 

 
 

As soon as you have loaded a file into the Source field, the In and Out points are displayed, and 
the length is calculated and displayed.  If for example you don’t need the first 30 frames of video 
converted, simply enter 00:00:01:00 into the Frame In field. 
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You will note that now the Clip Duration has been recalculated to the new length.  Converting this 
file now would omit any video frames found in the first 30 seconds of this clip. 

4.2.7 The Session Wizard 
 
The Session Wizard offers a way to convert all of the media files located in a specific folder.  The user 
may convert all media files or narrow down the conversion to files of a specific type.  Select the Session 
Wizard button from the toolbar.  
 

This button looks like this:  
 

 
 
Selecting the Session Wizard toolbar button opens up the above dialog box. 
 
You are instructed to navigate through your storage to find a source directory to get files from.  Selecting 
the “Recursive” button instructs MediaReactor to look for source files in the folder selected and all sub-
directories within that folder.  If Recursive has not been selected, the Session Wizard will only look for 
files in the folder selected and will ignore the media contained in any sub-directories. 
 
Selecting a file extension type from within the Filter pulldown menu instructs MediaReactor to look for 
files of that specific type only.  This would narrow down your search if you are looking for a specific file 
type.  Of course this will also remove all other file types from display within the Session Wizard for this 
session. 
 
Once you navigate through your storage and find the correct directory, select it and the directory path and 
name will be displayed in the box just above the network tree. 
 
When you are satisfied that your selections are correct, press the Next button.  Note that the user may 
select the Close button to cancel out of this operation at any time. 
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The next step will be to select a target folder.  This is where the converted files will be created.  Once you 
have selected a target folder, it will be displayed in the box just above the network tree. 
 
You can also name the session you are creating, as well as the workspace. 
 
When you are satisfied that the session is going to the right place as the right name and in the right 
workspace, select the Next button.  Note that not only may you Close to cancel out of this operation, but 
you may go Back and correct any choices you need to in the previous menu.  If the parameters you have 
set are correct for this dialog box, press Next. 
 

 
 
Now you will need to set the file parameters.  Adjust the type, codec, size and width, as well as make any 
choices regarding audio insertion or separate audio conversions in this dialog box.   
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Once you have determined that all of your choices are valid and useful, press the Next button to enter the 
Process section of the Session Wizard. 
 

 
 
Now you will need to set any processing parameters you wish to apply to the files you are going to create.  
These are the same options as on the Target Settings dialog box, so you may have some familiarity with 
them.  If you have selected “Recursive” earlier in the Session Wizard, the option to “Copy source tree 
structure” is selectable.  Select this to not only convert all the files in the directory and sub-directories, 
but to also copy the folders and subfolders in which the digital media files are contained. 
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Now you see the result of all of the choices you have made in the previous windows in the Session 
Wizard.  If all of these parameters are correct, press the Finish button to convert your files. 
 

 
 
The above prompt will open, offering you the choice to either open the workspace you have just created 
after it is generated, or to simply perform the conversion and not open the workspace. 
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4.3 Options 
 
The options menu offers an interface wherein the user can set certain default settings specific to 
MediaReactor. 
 
Select the Options menu, in the main menus, under Edit.  The following window will open: 
 

 
 

 
The following Configuration settings are offered here: 
 

Signal Format  This represents the default video standard that MediaReactor will use 
when creating a video stream from a series of still images. 
 
Enable Fast Meridien Enable the use of Fast Meridien file types. 
 
Max Compatibility Enable use of DigiSuite MAX? 
 
Use Internal Codecs (Omfi) Use internal library…. 
 
Disable Transcode Disable use of transcoding in MediaReactor file conversions. 
 
OMFI Field Dominance (on/off) When converting between OMFI file types, some types 
switch the dominance of the fields between even and odd-numbered fields.  When files are 
created with incorrect field dominance, there is a noticeable flicker as two fields from different 
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frames are being merged visually. Use this option to reverse the field dominance and correct the 
problem. 
 
Default File Type This represents the default file type that MediaReactor will create unless 
another file type has been selected. 
 
Compression This represents the default compression type that will be applied to target files 
unless another compression type has been selected. 

 
Audio Rate This represents the default sample rate of the audio file being created.   

 
The following Options settings are adjustable here: 
 

Add Associated Audio Files Some file types have their audio located in associated files 
separate from the video file.  Select this option to have MediaReactor find the associated audio 
files and use those audio files in the conversion.  
 
Splash Screen on/off Select this option to remove the splash screen from display or return it. 
 
Load Last Workspace Select this option to have MediaReactor load the last workspace saved 
upon opening MediaReactor. 
 
File Overwrite Notification Select this option to have MediaReactor notify you with an error 
message if you are about to engage in an activity which will overwrite your existing files. 

 
Default Output  Set the location where files will be created if the user does not select a 
target folder in MediaReactor.  

 
Apply Select this button to keep the changes you have just entered in this window.   
 
Done Select this button to close this window.  If you have selected “Apply” your changes will be 

retained. 
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4.4 License Options 
As detailed in the Installation section of this manual, we have demonstrated how to authorize your license 
for use.  There are other licensing options which will allow you to transfer or destroy your license. 
 

4.4.1 Transfer License 
 
In the main menus, under Edit/License, select Transfer. 

 
 
This opens up the Transfer License dialog box, offering the following options: 
 
Transfer  Select Transfer to open the following window: 
 

 
 
The Network Transfer section allows the user to pull the authorization out of their installation of 
MediaReactor and send it to a directory of folder on the network, or to another system residing on the 
same network.   
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The Floppy Transfer section allows the user to send the authorization for the installation of 
MediaReactor to a floppy disk, for the purpose of transferring the license to another system, or where 
there is no network connection. 
 

4.4.2 Destroy License 
 
The option to Destroy a license is available in the License section of the main menus, under Edit/License.  
It may be necessary to destroy a license if the user is experiencing problems with their MediaReactor 
software.  WARNING: the user should not select this procedure without a recommendation from Drastic 
Technical staff. 
 

 
 
When the user selects the Destroy command, the following window is opened: 
 

 
 
This warning message alerts the user to the fact that if the license is destroyed, the software will revert to 
“free” mode, with limited conversion options.  If the user selects “Yes”, the options granted in the 
authorization procedure will be revoked, and the user will now only be able to convert the supported 
formats to Real Media and Windows Media file types. 
 
If the user selects Yes, the license status dialog box will open to display the new status of their license. 
 

 
 
If the user tries to destroy the license on a free version, the following dialog box will open, alerting the 
user to the fact that this license has not been authorized for any options. 
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Note that the Destroy License procedure will not complete its removal of the license until you restart the 
MediaReactor software. 
 

 
 
 
Once the license has been destroyed, the user will now see a reduced list of target file types. 
 

4.4.3 License Status 
 
 Select License Status to open the following window: 
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License Status displays the various parameters of the current license status.  Following are the fields 
appearing in this dialogue box, and a brief explanation of their function. 
 

? Whether you are Authorized (True or False)  
 

? How many Copies you are licensed for (this will typically be 1 or 0) 
 

? The Type of license you have, (whether limited by time or unlimited) 
 

? If limited by days, the Allowed number of days 
 

? The number of days Used in a time-limited license   
 

? The Directory into which MediaReactor software has been installed 
 

? The Date Licensed (and the time). 
 

? The Level of MediaReactor licensed for use 
 

? The Options pulldown menu, listing all of the supported options enabled by this license 
 
 

4.5 Sessions 
 
A Session is all the information that defines an individual translation. When you are converting files with 
MediaReactor you will need to have at least one Session open. A translation can be performed from the 
Session itself or as part of a set of translation Sessions being run in a Workspace. 
 
The following sections will explain how to work with Sessions and give detailed information about 
translation parameters that the Session may contain. 

4.5.1 Working with Sessions 
 
When a Session is set up in MediaReactor, the parameters of a conversion are being defined. A Session 
retains information regarding the source file location, the target folder, and the target file parameters set 
up in the Target Settings window. 
 
To begin new sessions select the File menu.  Choose File/Session/New. 
 
You may also open an existing Session. MediaReactor will load the parameters defined in the selected 
Session. Choose File/Session/Open from the File menu and browse to select a saved Session file.  
 
Once you have set up a Session that you want to use again, you will need to save it.  In the main menus, 
under the File menu, select Session/Save As.  This will let you save the active Session.   
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Selecting Save As opens up the Save As dialog box.  Navigate through your storage for a location in 
which to store your sessions.  Note that the file type MediaReactor Session file type is selected. 
 

4.5.2 Selecting Source Files 
 
The first step in setting up a translation Session is to locate and select your source material. In the Session 
Window select the Browse button to browse through your storage for a source file. 
  

 
 
Selecting the Browse button offers the following “Open” dialog box.  Navigate through your storage to 
select an appropriate file. 
 

 
 
If there are many file types within the storage, it may take longer than necessary to find the file for 
conversion.    Narrow down the range of files displayed by selecting from the pulldown menu at the head 
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of the Source Files window.  Simply select the down arrow at the right of the Files of Type: field.  The 
pulldown menu will appear, and all applicable file types will be displayed.  Choose from among these to 
display only that file type.   
 
4.3.2.1 Source File Parameters 
 
In the Session window you may view information regarding the files you have selected.  Double-clicking 
on any one of the banners within this window (Video, Audio or Process) will open a chart for each of 
these categories of interest displaying information about the Source and Target files. 
 

 
 
Double-click on the Video tab to display the following information regarding the video portion of the 
Source and Target files: 
 

 
 
Video: 
 File Type: 
 Codec Type: 
 Width: 
 Height: 
 Bit Depth: 
 Frame Rate: 
 Quality: 
 Key Frame: 
 

 
Double-click on the Audio tab to display the following information regarding the audio portion of the 
Source and Target files: 
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Audio: 
 Samples/Sec: 
 Bits/Sample: 
 Quality: 
 Codec Type: 
 File Type: 
 

 
Double-click on the Process tab to display the following information regarding the process portion of the 
Source and Target files: 
Process: 
 Disable Transcode: 
 Dual Mono: 
 2/3 Drop: 
 A Frame: 
 Type: 
 Threshold: 
 Edge: 
 P3: 
 Audio: 



 

Drastic Technologies Ltd.   38 

 

4.5.3 Previewing Source Files 
 
Once you have selected a Source File, it is possible to use the built-in viewer to preview this file and 
confirm that it is the correct file.  With a Session loaded, and a file selected in the Source File field, go to 
the toolbar.   
 

Select the Preview Source  button.  This opens the viewer and allows you to preview your file. 
 

 
 
The user may re-size the viewer to one of three sizes.  This allows the user to compensate for differing 
visual monitoring requirements. 
 
In the preview window, the user will see a set of transport controls analogous to a home VCR.  Play, stop, 
pause, fast forward and so on are all present on the viewer.  Use this viewer to confirm the veracity of 
your source file selection. 
 

4.5.4 Previewing Target Files 
Once you have selected a Target File, it is possible to use the built-in viewer to preview this file and 
confirm that it is the correct file.  With a Session loaded, and a file selected in the Target File field, go to 
the toolbar.   
 

Select the Preview Target  button.  This opens the viewer and allows you to preview your file. 
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The user may re-size the viewer to one of four sizes.  This allows the user to compensate for differing 
visual monitoring requirements. 
 

In the preview window, the user will see a set of transport controls analogous to a home VCR.  Play, 
stop, pause, fast forward and so on are all present on the viewer.  Use this viewer to confirm the 
successful completion of your target file adjustments. 

 
 

4.5.5 Setting up the Target Files 
 
Target Settings 
 
Once you have selected the source file, you will need to set the parameters of the target file (the file you 
are going to create).  Confirm that the Target Settings window is open.  If it is not, use the View menu to 
select it. 
 

 
File Settings 

 
Target Settings window – File Settings Tab 
 
Confirm that the File Settings tab near the bottom of the Target Settings window is selected.  When 
selected, the tab will be blue. 
 

? Target Folder The Target Folder pulldown menu will display the location selected in the 
Session Manager window. You may have already set the location in the Session window, but you 
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may adjust it here if needed.  Select the “down” arrow at the right side of this menu to reveal the 
network tree for navigation. 

? File Type The File Type pulldown menu allows the user to select the target file type.  
Depending on which file type you select in this field, you will see different choices offered in the 
subsequent fields.  The file types displayed in this menu depend on which level of MediaReactor 
you have installed.  Select the “down” arrow at the right side of this menu to reveal the file types. 

? Codec Type Translate the source media to this compression / decompression (codec) format. 
This field will give you a drop-down menu of the available codecs. This list will include the 
codecs built into MediaReactor as well as any other codecs installed on the workstation. Select 
the “down” arrow at the right side of this menu to reveal the available choices.  Select from this 
list. 

? Height  This field sets the height in pixels of the translated image. Some file types and 
codec formats may impose these limitations:  

? a specific vertical size  
? a minimum vertical size.  
? a maximum vertical size.  
? a vertical size that is a multiple of a particular step size.   

Edit the Height field to change the value and MediaReactor will accept the change if it is 
supported or substitute the closest value otherwise.  For file types with adjustable sizing, the “up” 
and “down” arrows increment in steps representing available height choices. 

? Width  This field sets the width in pixels of the translated image. Some file types and 
codec formats may impose these limitations: 

? a specific horizontal size  
? a minimum horizontal size.  
? a maximum horizontal size.  
? a horizontal size that is a multiple of a particular step size.   

Edit the Width field to change the value and MediaReactor will accept the change if it is 
supported or substitute the closest value otherwise.  For file types with adjustable sizing, the “up” 
and “down” arrows increment in steps representing available width choices. 

? Bit Depth This field sets the number of bits per pixel that controls the color resolution of 
the translated image. Some file types and codec formats may impose limitations on this setting. 
Edit the Bits field to change the value and MediaReactor will accept the change if it is supported 
or substitute the closest value otherwise. You can also use the up/down arrow buttons to select the 
from the available bit depths. 

? Quality  This field sets the quality factor of the compression scheme of the translated 
image data. Some file types and codec formats will support this setting. If it is supported 
MediaReactor will allow you to edit the Quality field to change the value.   For file types with 
adjustable quality, the “up” and “down” arrows increment in steps representing available choices. 

? Data Rate This field sets a target data rate for the compression scheme of the translated 
image data. Some file types and codec formats will support this setting. If it is supported 
MediaReactor will allow you to edit the Data Rate field to change the value. This value is 
expressed as Kilobytes per Second.  For file types with adjustable data rates, the “up” and “down” 
arrows increment in steps representing available choices. 

? Key Frame This field sets the interval between key frames for the codec of the translated 
image data. Some file types and codec formats will support this setting. If it is supported 
MediaReactor will allow you to edit the Key Frame field to change the value. This value is 
expressed as a number of frames.  For file types with adjustable key frame intervals, the “up” and 
“down” arrows increment in one frame steps. 
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? Audio Type The Audio Type pulldown menu becomes available when the user selects 
“Separate Audio”.  Select the type of audio file you wish to create using the pulldown menu.  The 
audio file type choices available depend on the version of MediaReactor you have. 

? Compression Select the level of compression to be applied to the separate audio file.  This only 
becomes active when the user has selected Separate Audio.  Note that some audio file type 
choices will not offer adjustable compression. 

? Sample Rate The Sample Rate applied to the target audio is displayed here.   This only 
becomes active when the user has selected Separate Audio.  Note that some audio file type 
choices will not offer adjustable sample rates. 

? Bits/Sample The Bits per Sample ratio of the target audio file is set here.   Note that some 
audio file type choices will not allow the user to adjust the bits per sample ratio. 

? Separate Audio Select this to create separate files from a file that contains audio and 
video, one file for video (or series of still images) and one or more files for audio. Some systems 
require their audio source material to be in another file. Check in the compatibility section for 
information about these systems. 

? Audio Only Select this checkbox to prevent the creation of a new video file during this 
conversion.  This only becomes active when the user has selected Separate Audio. 

? Dual Mono Select this checkbox to create two “mono” audio files (using the audio from the 
source video file) not associated with the source video file.  Some systems require their audio 
source material to be in another file. Check in the compatibility section for information about 
these systems.  This only becomes active when the user has selected Separate Audio. 

 
Target Settings window – Add Process tab  
 

 
Target Settings window – Process tab 

 
Target Settings window – Process Tab 
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The Process Tab offers certain advanced file processing features and adjustments not present on the File 
Settings tab. 
 
To access these features, confirm that the Process tab near the bottom of the Target Settings window is 
selected.  When selected, the tab will be blue. 
 

? Add Process This check box enables the processing and allows you to select the type of 
processing from the pulldown menu. 

? Process Type Use this pulldown menu to select between the available processes.  Choices here 
include: Blend Fields, De-interlace Blend, De-interlace Interpolate, Duplicate Field 1, Duplicate 
Field 2, Flip Horizontal, Flip Vertical, and Invert Fields. 

? Edge This field sets an edge value for the de-interlace processing. The edge value controls the 
detection of intra-field artifacts as opposed to actual high frequency content in the image. The 
greater the value of the edge setting the more likely an edge in the image will be blended.  The 
default value should be adequate for most processing but if you need to adjust it do so carefully. 

? P3 This feature is not implemented in this version of MediaReactor. 
? Thres (Threshold) This field sets a threshold value for the de-interlace processing. The 

threshold value controls the detection of the intra-field motion of an object. The greater the 
motion of an object between fields the higher the threshold needs to be set so it will be detected 
and used in the blending process.  The default value should be adequate for most processing but if 
you need to adjust it do so carefully. 

? 2/3 Drop Select this checkbox to implement the conversion between film rate and NTSC 
video.  The Add, Remove, and A Frame fields set the parameters of this conversion. 

? Add Select Add if you have a film rate file (24 fps) and you need to “Add” frames to convert 
this file to NTSC frame rate. 

? Remove Select this checkbox if you have an NTSC file generated on a Telecine and you 
need to remove the “inserted” frames to end up with a 24 fps file. 

? A Frame The “A Frame” represents the first frame of inserted video generated by the 
Telecine.  Setting the A Frame involves stepping though the file by frames to find the first 
“jittery” frame.  This will be the first frame generated by the Telecine.  Note its location by time 
code and enter this value into the “A Frame” field.  This synchronizes the addition or removal of 
all of the inserted frames, as they occur at predictable intervals. 

 
Performing the Conversion 
 
Once you have addressed the above considerations the conversion may be started.  This indicates that you 
have selected what type of file you are starting with, where it is located, what type of conversion is taking 
place (what type of file it will become), and where the files are going.  Performing this conversion is as 
easy as clicking on the Convert Sessions button at the bottom of the Target Settings window.   
 

 
 
Selecting this button opens the Translation Setup window, offering you a choice of the available sessions 
you have saved.  Select the session or sessions you wish to perform at this time. 
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Once you select a session or sessions for conversion and press the Convert button, the Translation 
Setup window will display the conversion parameters you have created, as well as the progress of the 
conversion. 
 

 
 
The above diagram shows the conversion progress bars.  There is a bar for the progress of the current 
session, and a bar for the progress of all of the sessions selected for conversion.  Note too that this menu 
contains an Abort button.  Clicking on this button with the mouse, or pressing Enter on the keyboard 
during the conversion will cancel the process at this point. 
 

4.5.6 The Session Manager 
 
An important feature of the MediaReactor software is the ability to handle a number of sessions within 
one workspace.  To select between active sessions, select the session you want using your mouse.  If you 
right click on the session name, the following dialog box will open: 
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Selecting Open will allow the user to browser through their storage to find a session to open.  This will 
add a Session to the existing workspace. 
 
Selecting Save will save the Session upon which the user has right-clicked.  A Save As dialog box will 
open, and the file type “MediaReactor Session” will display in the File Type field. 
 
Selecting Close will close the Session upon which the user has right-clicked.  If any changes have been 
made since the user opened the Session, the user will be prompted either to Save the file or close it. 
 
Selecting Delete will delete the Session upon which the user has right-clicked. 
 

4.6 The Workspace 
 
The MediaReactor Workspace acts as a manager for your translation Sessions.  A Workspace may be 
used as an organizational tool by acting as a container for related translation Sessions. 
 
When MediaReactor is first started it is working within a new Workspace.  You will not however see a 
window entitled Workspace.  If you close MediaReactor, you will be prompted to Save (any open 
Sessions and then) the Workspace you are working within.  From then on MediaReactor will load the last 
Workspace you saved upon opening. 

4.6.1 Creating a Workspace 
 
You do not need to do anything to create the initial New Workspace.  As soon as you open 
MediaReactor, you are working within a Workspace.  Any Session you create will be saved within this 
workspace.  Once you try to close any unsaved Sessions, you will be prompted to save them, and then to 
save the workspace.  You can only have one Workspace open at a time.  If you try to open a second 
Workspace by pressing “New Workspace”, you will be prompted to save any sessions you have open, 
and to save the current workspace. 

4.6.2 Open a Workspace 
 
If you have saved any workspaces, they may be opened as needed.  Each workspace will load any 
sessions contained within them and all of their associated file parameters.  Go to the main menus, under 
File/Workspace/Open.  The following dialog box will open: 
 



 

Drastic Technologies Ltd.   45 

 
 
This is a standard Windows browser, which allows you to navigate through your storage to find the 
workspace you need.  Once you find the workspace file you want, select Open to open it.   
 

4.6.3 Adding Sessions to and Removing Sessions from a Workspace 
 
You may add sessions to a workspace.  Once you have a workspace open, whether it is saved or not, 
select Open Session.  Browse through your storage to find the Session you want to load into this 
workspace.  You may also open a saved Session using the right click “Open” option in the Session 
Manager window. 

4.6.4 Working with Multiple Sessions 
 

 
 
When working with multiple Sessions the Session Browser window is used to display any open Sessions.  
You may also select which Session is active in this window. 
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To change the settings of a Session make it active by double clicking on it in the Session Browser 
window or select the session by clicking on its window in the MediaReactor interface. The Session 
window will load the Session’s parameters and allow you to edit them. 
 
The ability to work with a number of Sessions in the same Workspace allows MediaReactor to automate 
the conversion of a group of files. You can create new or add existing Sessions to a Workspace then have 
all or some of those translations executed one after another. The conversions will start at the Session at 
the top of the Workspace and work down the list. 

4.7 Customizing the User Interface 
 
The MediaReactor user interface allows you to configure it to best suit your preferences. Contained 
within the main window of the program you may choose the components to be displayed, where they are 
placed and what size they are according to your needs. MediaReactor conforms to the Microsoft Windows 
guidelines for designing a user interface. If you are familiar with other Windows applications then the 
controls of MediaReactor should be familiar to you. 
 
The MediaReactor interface components that you can customize are: 
 
? the Toolbar (can be opened/closed) 
? The Status Bar (can be opened/closed) 
? The Source Window (can be opened/closed, undocked from the interface and re-sized) 
? The Target Settings (can be opened/closed – cannot be docked with the interface) 
? The Session Manager/Session Browser (can be opened/closed, undocked from the interface and 

resized) 
? The Output Manager (can be opened/closed, undocked from the interface and resized) 
 

4.7.1 Display Visibility 
 
The MediaReactor windows and toolbars can be displayed to suit either your preferences or the 
organizational requirements of your working environment. The View menu lets you select what windows 
or toolbars will be visible. All the windows and any toolbars that are not docked also provide buttons that 
allow them to be closed.  

4.7.2 Display Sizing 
 
The MediaReactor windows and toolbars can be re-sized to suit either your preferences or the 
organizational requirements of your working environment. All the windows and any toolbars that are not 
docked provide the means to be scaled to the size you require. To control sizing MediaReactor has the 
standard Windows functions i.e. the mouse pointer becomes a scaling arrow, indicating that the border of 
a window can be moved to resize it.  

4.7.3 Display Location 
 
The MediaReactor windows and toolbars can be located to suit either your preferences or the 
organizational requirements of your working environment. The windows and toolbars may be moved to 
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any position you prefer by dragging their title bar with mouse. You can also have any of the toolbars and 
windows except for the Target Settings window dock with the interface. 
 

 
 
In the above layout, the Source Browser, the Session Browser and the Output Window are undocked and 
on the desktop.  They have been re-sized to optimize use of the available desktop space and the 
organizational requirements of the user.   
 
The Session windows are “cascaded” to show a corner of each session except for the active session on 
top, shown in its entirety. 
 
The Target Settings window is never docked with the MediaReactor interface and may not be resized.   
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5 Reference Guide 
 
This guide provides information about the MediaReactor user interface, the file types and formats that 
MediaReactor supports and a glossary of terms used in this manual. 

5.1 User Interface 
 
This section gives a description of each component that make up the MediaReactor user interface. If you 
need to determine what a component is or its function use this section to look it up. 

5.1.1 Main Menus 
 

Following are the main menus and their functions.  A number of these functions are duplicated elsewhere, 
and this redundancy is built in for the convenience of the operator.   

5.1.1.1 The File Menu 
 

 
 
Session New – opens a new session   

Open – opens a saved session 
Save – save the active session 
Save As – save the active session in the user-selected folder with a 
new name. 

Workspace New – open a new workspace 
Open – opens a saved workspace 
Close – close the current workspace 
Save – save the current workspace 
Save As – save the active workspace in the user-selected folder with 
a new name. 

Recent Sessions Displays the list of sessions recently saved.  Select a session here to 
load it into this workspace, or to select this session as the active one 
in the current workspace if it is already contained in the active 
workspace. 

Recent Workspace Displays a list of recently saved workspaces.  When you select a 
workspace here other than the active workspace, you will be 
prompted to save any open sessions and to save the active workspace. 
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5.1.1.2 Edit Menu 
 

 
 
Options Options – opens the Options menu 
License Authorize – opens the Authorization dialog box, allowing the user to 

authorize their software for use, upgrade or destroy their 
authorization. 
Transfer – allows the user to transfer their license authorization to a 
system on the network or to a floppy either for backup purposes or to 
perform system maintenance which might engage the software 
protection. 
View Status – opens the Drastic License Info box, displaying the 
particulars of this installation and what the software is licensed for in 
this instance. 
Destroy – permanently destroys the license and causes the software 
to revert to “free” mode, offering limited translation features.  

 

5.1.1.3 The View Menu 
 

 
 
Toolbar toggles the toolbar on or off 
Status Bar toggles the status bar on or off 
Source Browser toggles the source window on or off 
Target Settings toggles the target settings window on or off 
Session Manager/Browser toggles the session manager/browser window on or off 
Output Window toggles the output window on or off 
List of open sessions displays a list of open sessions – not necessarily all of the sessions in 

the workspace 
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View More Windows 
 
If you have more sessions open than your View menu will list, the last option on the View menu list will 
be the “More Windows…” option.  Selecting this option allows the user to enter the Select Window 
dialog box, with a list of currently open sessions. 
 

 
 
Select Window 
 
Choosing the More Windows option in the View menu offers up the below Select Window dialog box, 
allowing the user to browse through a list of open session windows to select the one they wish to view. 
 

 

5.1.1.4 Help Menu 
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About MediaReactor v2.0… Select this to open the “splash” screen, listing the version number of 
MediaReactor you are working with. 

 

5.1.2 The Toolbars 
 
A number of menu functions are duplicated on the Toolbar for quick one-button access.  
 

 
 
The Toolbar consists of the several icons below the main menus, and may be displayed or removed by 
toggling its display in the main menus within the pulldown menu under View.  The functions of these 
buttons are as follows:  
 
Session Wizard The Session Wizard allows the user to select a 

folder or set of folders and convert all the media 
within them to a specific format.  The user may 
convert the files and drop them into one folder, or 
convert all the files and maintain the 
folder/directory structure of the selected items. 

Go (Convert) This is the same as the Convert Sessions button.  
Selecting this button brings up the Translation 
Setup window, allowing the user to select a session 
or sessions to convert 

 
Source Browser toggles the Source Browser on or off 
Target toggles the Target Settings window on or off 
Help Opens the “splash” screen, which displays the version number of 

MediaReactor you are working with. 
New Workspace This opens a new workspace.  The user will be prompted to save any 

changes made in the workspace before closing. 
Open Workspace Opens a saved workspace.  If the user does not close their existing 

workspace, they will be prompted to do so before they will be able to 
open a new workspace.  They may also save any sessions and 
workspaces or choose not to save any changes. 

Save Workspace Save the active workspace.  If the workspace has not been saved 
before, the user will be prompted to select a location for the 
workspace and a file name. 
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Close Workspace Close the active workspace.  If the user has not done so already, they 
will be prompted to save any sessions they have made changes to.  
Also, if the workspace or any files in it have changed, the workspace 
will need to be saved. 

Previous Session Use this arrow to move up though the list of open sessions.  
Selecting previous will de-activate the current session and shift the 
focus to the session immediately above (previous to) that session. 

Next Session Use this arrow to move down though the list of open sessions.  
Selecting next will de-activate the current session and shift the focus 
to the session immediately below (after) that session. 

New Session Open a new session. 
Open Session Open a session that has been saved.  Opens a Windows “Open” 

dialog box, allowing the user to navigate through their storage for a 
session.  Note that the “Files of Type” field has been narrowed down 
to the type: MediaReactor Session [*.mrs].  This allows the user to 
only “see” session files within this dialog box. 

Save Session Save the active session. 
Close Session Close the active session.  If any changes have been made to the 

session since the last time it was saved, the user will be prompted to 
save the session. 

Delete Session Deletes the active session.  Note that all session information 
associated with this session will be lost.  This activity will not delete 
any media files. 

Preview Source If you have a source file selected in the Source Browser, you may 
select this button to preview it on your VGA monitor.  If the selected 
file is an audio file, it will still play (provided you have audio 
hardware installed) using the transport controls on the preview 
interface. 

Preview Target If you have converted a file and wish to view it to confirm the file 
has been properly processed, you may preview it on your VGA 
monitor using this button 

Browse Browse for media to preview using this button.  If you are unsure 
about what you are looking for and wish to view a few files before 
loading them into the Source Browser, use this button to preview the 
files. 

 



 

Drastic Technologies Ltd.   53 

 

5.1.3 Windows 
 
The windows contained within the MediaReactor interface are where all your work will be done. The 
most important window is the Session window as that is where file translations are set up and executed. 
The Session manager window helps you organize and execute multiple translations. The other windows 
provide information about the operation of MediaReactor and the files which it is working on. 

5.1.3.1 The Source Browser  
 
The Source Bowser displays the navigation tree associated with the source file selected in the current or 
active session.  If no source file has been chosen or if there is no session opened, this will display the 
navigation tree with the folders all closed. 
 

 
 
If there is no session opened and the user selects a source file, a prompt will open and ask the user if they 
want to open a new session. 
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5.1.3.2 The Session Browser 
 

 
 
The Session Browser window shows at a glance which sessions are open, and what their names are.  De-
selecting this window (in the main menus under View) will cause it to disappear, which will leave room 
for other, possibly more important things. 

5.1.3.3 Target Settings window 
 

 
 
The Target Settings window displays the target file settings associated with the current or active session.  
Use this window to determine what type of file you are going to create during the conversion process. 
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The various parameters you can adjust in this window are as follows: 
 

? Target Folder The Target Folder pulldown menu will display the location selected in the 
Session Manager window. This target folder menu allows the user to change the folder 
assignation of the target file if necessary.  Select the “down” arrow at the right side of this menu 
to reveal the network tree for navigation. 

? File Type The File Type pulldown menu allows the user to select the target file type.  
Depending on which file type you select in this field, you will see different choices offered in the 
subsequent fields.  The file types displayed in this menu depend on which level of MediaReactor 
you have installed.  Select the “down” arrow at the right side of this menu to reveal the file types. 

? Codec Type Translate the source media to this compression / decompression format. This 
field will give you a drop-down menu of the available codec formats. This list will include the 
formats built into MediaReactor as well as any other codecs installed on the workstation. Select 
the “down” arrow at the right side of this menu to reveal the available codecs.  Select from this 
list. 

? Height  This field sets the height in pixels of the translated image. Some file types and 
codec formats may impose these limitations:  

? a specific vertical size  
? a minimum vertical size.  
? a maximum vertical size.  
? a vertical size that is a multiple of a particular step size.   

Edit the Height field to change the value and MediaReactor will accept the change if it is 
supported or substitute the closest value otherwise.  For file types with adjustable sizing, the “up” 
and “down” arrows increment in steps representing available height choices. 

? Width  This field sets the width in pixels of the translated image. Some file types and 
codec formats may impose these limitations: 

? a specific horizontal size  
? a minimum horizontal size.  
? a maximum horizontal size.  
? a horizontal size that is a multiple of a particular step size.   

Edit the Width field to change the value and MediaReactor will accept the change if it is 
supported or substitute the closest value otherwise.  For file types with adjustable sizing, the “up” 
and “down” arrows increment in steps representing available width choices. 

? Bit Depth This field sets the number of bits per pixel that controls the color resolution of 
the translated image. Some file types and codec formats may impose limitations on this setting. 
Edit the Bits field to change the value and MediaReactor will accept the change if it is supported 
or substitute the closest value otherwise. You can also use the up/down arrow buttons to select the 
from the available bit depths. 

? Quality  This field sets the quality factor of the compression scheme of the translated 
image data. Some file types and codec formats will support this setting. If it is supported 
MediaReactor will allow you to edit the Quality field to change the value.   For file types with 
adjustable quality, the “up” and “down” arrows increment in steps representing available choices. 

? Data Rate This field sets a target data rate for the compression scheme of the translated 
image data. Some file types and codec formats will support this setting. If it is supported 
MediaReactor will allow you to edit the Data Rate field to change the value. This value is 
expressed as Kilobytes per Second.  For file types with adjustable data rates, the “up” and “down” 
arrows increment in steps representing available choices. 

? Key Frame This field sets the interval between key frames for the compression scheme of the 
translated image data. Some file types and codec formats will support this setting. If it is 
supported MediaReactor will allow you to edit the Key Frame field to change the value. This 



 

Drastic Technologies Ltd.   56 

value is expressed as a number of frames.  For file types with adjustable key frame intervals, the 
“up” and “down” arrows increment in one frame steps. 

? Audio Type The Audio Type pulldown menu becomes available when the user selects 
“Separate Audio”.  Select the type of audio file you wish to create using the pulldown menu.  The 
audio file type choices available depend on the version of MediaReactor you have. 

? Compression Select the level of compression to be applied to the separate audio file.  This only 
becomes active when the user has selected Separate Audio.  Note that some audio file type 
choices will not offer adjustable compression. 

? Sample Rate The Sample Rate applied of the source audio is displayed here.   This only 
becomes active when the user has selected Separate Audio.  Note that some audio file type 
choices will not offer adjustable sample rates. 

? Bits/Sample The Bits per Sample ratio of to the source audio file is displayed here.   Note that 
some audio file type choices will not allow the user to adjust the bits per sample ratio. 

? Separate Audio Select this to create two separate files from a file that contains audio and 
video, one file for audio and one file for video (video or still image stream). Some systems 
require their audio source material to be in another file. Check in the compatibility section for 
information about these systems. 

? Audio Only This only becomes active when the user has selected Separate Audio.  Select this 
checkbox to prevent the creation of a new video file during this conversion. 

? Dual Mono This only becomes active when the user has selected Separate Audio.  Select this 
checkbox to create two “mono” audio files (using the audio from the source video file) not 
associated with the source video file.  Some systems require their audio source material to be in 
another file. Check in the compatibility section for information about these systems. 

 
Target Settings window – Add Process tab 
 

 
Target Settings window – Process tab 
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Target Settings window – Process Tab 
 
The Process Tab offers certain advanced file processing features and adjustments not present on the File 
Settings tab. 
 
To access these features, confirm that the Process tab near the bottom of the Target Settings window is 
selected.  When selected, the tab will be blue. 
 

? Add Process This check box enables the processing and allows you to select the type of 
processing from the pulldown menu. 

? Process Type Use this pulldown menu to select between the available processes.  Choices here 
include: Blend Fields, De-interlace Blend, De-interlace Interpolate, Duplicate Field 1, Duplicate 
Field 2, Flip Horizontal, Flip Vertical, and Invert Fields. 

? Edge This field sets an edge value for the de-interlace processing. The edge value controls the 
detection of intra-field artifacts as opposed to actual high frequency content in the image. The 
greater the value of the edge setting the more likely an edge in the image will be blended.  The 
default value should be adequate for most processing but if you need to adjust it do so carefully. 

? P3 This feature is not implemented in this version of MediaReactor. 
? Thres (Threshold) This field sets a threshold value for the de-interlace processing. The 

threshold value controls the detection of the intra-field motion of an object. The greater the 
motion of an object between fields the higher the threshold needs to be set so it will be detected 
and used in the blending process.  The default value should be adequate for most processing but if 
you need to adjust it do so carefully. 

? 2/3 Drop Select this checkbox to implement the conversion between film rate and NTSC 
video.  The Add, Remove, and A Frame fields set the parameters of this conversion. 

? Add Select Add if you have a film rate file (24 fps) and you need to “Add” frames to convert 
this file to NTSC frame rate. 

? Remove Select this checkbox if you have an NTSC file generated on a Telecine and you 
need to remove the “inserted” frames to end up with a 24 fps file. 

? A Frame The “A Frame” represents the first frame of inserted video generated by the 
Telecine.  Setting the A Frame involves stepping though the file by frames to find the first 
“jittery” frame.  This will be the first frame generated by the Telecine.  Note its location by time 
code and enter this value into the “A Frame” field.  This synchronizes the addition or removal of 
all of the inserted frames, as they occur at predictable intervals. 

 
All of the settings adjusted within the Target Settings window are saved within the Sessions themselves. 
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5.1.3.4 The Output Window 
 
The Output window lists all activities that take place within MediaReactor.  If you save a file or create a 
file, it is noted in the Output window.  Any errors are listed in this window as well as any actions stopped 
etc. 
 

 
 
The activities display the following fields: Level, Message, Date and Time.  The user may not re-
sequence these messages by category title.  For example, selecting the “Time” heading above the 
messages does not re-sort the messages by the time of creation. 
 
The Level category shows three categories of level.  There are green messages, noting events only with 
no level of alarm.  There are yellow messages, such as a user-initiated Abort conversion command.  These 
indicate that the user may wish to examine the event to determine if there is a problem.  The last level of 
error messages is red, indicating a problem that the user should definitely address in order to attain proper 
functionality from MediaReactor. 
 
The Message category details the activity documented in this window.  File creation/deletion, 
Conversions and so on will be detailed here. 
 
The Date category details the date the message was generated. 
 
The Time category details the time of day the message was created. 
 
The user may save the list of events generated in the Output window.  Right Click on any event in the 
Output Window.   
 

 
 
This opens the right click options, allowing the user to clear the events detailed here, or to save the list of 
events detailed here as a “MediaReactor Log”.  Selecting Clear will remove all of the events from the 
Output Window.  Selecting Save will open the following Save As dialog box, allowing the user to save 
their Output Window events as a MediaReactor Log file. 
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Navigate to a folder in which you want to store this log file.  Name the file by entering a name in the field 
to the right of the words “File Name:” using your keyboard.  Select “Save” and the file will be saved in 
this location.   
 
If you want to open the log file, navigate to the folder in which you have stored the log file.  Select the log 
file.  Right click on it and select Open With.  Choose the Notepad software and view the messages as a 
text file. 
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5.1.3.5 The Status Bar 
 
The Status Bar is shown below, and displays the current status of MediaReactor. 
 

 
 
Simply toggling the selection of the Status Bar to remove it from the View can save a good third of an 
inch.  If the Status Bar disappears, however, and it is used often enough to miss it, its display selector is 
located in the View menu.  The check mark under the View menu next to each of these windows indicates 
whether these windows are opened or not 

5.1.3.6 The Preview Display 
 

 
 
The Preview Display offers a way for the user to preview files on the VGA monitor (if they are video 
files) and through their audio hardware if they are audio files.  This utility is opened though the toolbar.   
 
Select Preview Source to find and play the source file (the file you need to convert).   
 
Select Preview Target if you have converted a file and you need to view it to confirm the results.   
 
Select Browse Preview if you need to view some files you have on storage. 
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5.2 Media Formats 
 
MediaReactor supports the reading and writing of digital media files containing video, audio and still 
image data. The following section lists the supported file types and codecs that are available for use with 
them.  
 
There are also notes relating to topics such as application support and resolution. 

5.2.1 Video for Windows (AVI) 
 
Media Reactor supports Microsoft’s Video for Windows file type. It provides a set of custom codecs that 
support specific hardware standards. It also supports third party software codecs. 
 
The custom compression / decompression modules appear with the other codecs that are installed in the 
system but they are built into the Media Reactor software. These codecs provide the access to the 
hardware specific translation capabilities of Media Reactor. 
 
Codec Notes 
Drastic VVW 1x00 series 
Native Format 

1000 series Drastic Technologies Digital Disk Recorder 

Drastic VVW 3x00 series 
Native Format 

3000 series Drastic Technologies Digital Disk Recorder 

Matrox – DigiSuite Open 
DML Motion JPEG 

Matrox DigiSuite and DigiSuite LE hardware. These platforms are used 
in systems running IMC – Incite, Discreet – edit*, in-sync- Speed razor 
and Adobe Premiere RT 

Matrox – Rainbow Runner 
MJPEG 

Matrox ‘s Rainbow Runner. This is a cost effective Motion JPEG 
solution from Matrox. 

Matrox – M-JPEG Lossless  
Pinnacle / Miro – DC30 / 
DC50 

Pinnacle’s DC30 and the DC50. These platforms are used in systems 
running Adobe Premiere and After Effects. 

Pinnacle Reeltime Pinnacle Reeltime hardware. This platform supports Adobe Premiere 
and in-sync Speed Razor 

Targa RTX Motion JPEG – 
Edit Option 2 

Pinnacle TARGA 2000. These platforms are used in systems running 
Discreet – edit* , in-sync Speed Razor and Adobe Premiere RT 

Uncompressed (no codec) RGB uncompressed video 
 
Video for Windows uses software codecs. These modules may come from a number of manufacturers. 
For maximum compatibility, Media Reactor will attempt to use any software codecs that are installed on 
the system.  
 
MediaReactor will also install some software codecs to provide compatibility with hardware that is not in 
your system. These codecs will be available for any other application that can use Video for Windows. 
 
The following is a list of codecs that MediaReactor will install. 
 
Codec Notes 
Matrox DV / DVCAM Matrox Digiserver DTV. 
Matrox DVCPRO Matrox Digiserver DTV. 
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Codec Notes 
Matrox DVCPRO50 Matrox Digiserver DTV. 
Matrox MPEG 2 I-frame Matrox Digiserver DTV. 
 
The following is a list of third party codecs that have been tested with Media Reactor. 
 
Codec Notes 
Cinepak Cinepak codec from Radius 
DivX  - DIV3  
DivX  - DIV4  
Intel 263  
Indeo® video 5.0  
Intel Indeo® Video R3.2  
Intel Indeo® Video R4.5  
Microsoft Video 1  (CRAM) 
MS-MPEG4 V1  
MS-MPEG4 V2  
MS-MPEG4 V3 This codec does not encode files. 
MS-RLE  

5.2.2 Open Media Framework Interchange (OMF) 
 
Media Reactor supports the Open Media Framework Interchange file type. This is used by a number of 
products from Avid Technology Inc. Media Reactor has software codecs that support Avid’s NuVista, 
ABVB and Meridien compression hardware. MediaReactor provides software codecs to support the Targa 
compression hardware used in the MCXpress NT systems. MediaReactor also supports uncompressed 
YUV 4:2:2, TIFF RGB and RGBA video in the OMFI container. 
 
MediaReactor is capable of working with either OMF Interchange Specification Version 1.0 or 2.1 files. 
All the supported video formats are available in both of these versions. 
 
Codec Notes 
AVR 1 NuVista 320 X 240 (288PAL) 1 Field 
AVR 12 ABVB 720 X 243 (288PAL) 2 Field 
AVR 1e NuVista 320 X 240 (288PAL) 1 Field 
AVR 2 NuVista 320 X 240 (288PAL) 1 Field 
AVR 25 NuVista 640 X 240 (288PAL) 2 Field 
AVR 26 NuVista 640 X 240 (288PAL) 2 Field 
AVR 27 NuVista 640 X 240 (288PAL) 2 Field 
AVR 2e NuVista 320 X 240 (288PAL) 1 Field 
AVR 2m ABVB 352 X 243 (288PAL) 1 Field 
AVR 2s ABVB 720 X 243 (288PAL) 1 Field 
AVR 3 NuVista 640 X 240 (288PAL) 1 Field 
AVR 3e NuVista 320 X 240 (288PAL) 1 Field 
AVR 3m ABVB 352 X 243 (288PAL) 1 Field 
AVR 3s ABVB 720 X 243 (288PAL) 1 Field 
AVR 4 NuVista 640 X 240 (288PAL) 1 Field 
AVR 4e NuVista 640 X 240 (288PAL) 1 Field 
AVR 4m ABVB 352 X 243 (288PAL) 1 Field 
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Codec Notes 
AVR 4s ABVB 720 X 243 (288PAL) 1 Field 
AVR 5 NuVista 640 X 240 (288PAL) 1 Field 
AVR 5e NuVista 640 X 240 (288PAL) 1 Field 
AVR 5m ABVB 352 X 243 (288PAL) 1 Field 
AVR 6e NuVista 640 X 240 (288PAL) 1 Field 
AVR 6m ABVB 352 X 243 (288PAL) 1 Field 
AVR 6s ABVB 720 X 243 (288PAL) 1 Field 
AVR 70 ABVB 720 X 243 (288PAL) 2 Field 
AVR 71 ABVB 720 X 243 (288PAL) 2 Field 
AVR 75 ABVB 720 X 243 (288PAL) 2 Field 
AVR 77 ABVB 720 X 243 (288PAL) 2 Field 
AVR 8s ABVB 720 X 243 (288PAL) 1 Field 
AVR 9s ABVB 720 X 243 (288PAL) 1 Field 
JFIF 15:1s Meridien 352 X 243 (288PAL) 1 Field 
JFIF 2:1  Meridien 720 X 243 (288PAL) 2 Field 
JFIF 2:1s Meridien 352 X 243 (288PAL) 1 Field 
JFIF 20:1  Meridien 720 X 243 (288PAL) 2 Field 
JFIF 3:1  Meridien 720 X 243 (288PAL) 2 Field 
JFIF 4:1s  Meridien 352 X 243 (288PAL) 1 Field 
Uncomp422 Uncompressed YUV 720 X 243 (288PAL) 2 Field 
TIFF RGB Uncompressed Uncompressed RGB 720 X 243 (288PAL) 2 Field 
Uncompressed RGBA Uncompressed RGB with Alpha 720 X 243 (288PAL) 2 Field 
MCXpress NT Targa 720 X 486 (288PAL) 2 Field 
 

5.2.3 QuickTime (MOV) 
 
Media Reactor supports Apple’s QuickTime file type. It provides a set of custom codecs that support 
specific software and hardware standards. It also supports third party software codecs. 
 
The custom compression / decompression modules appear with the other codecs that are installed in the 
system but they are built into the Media Reactor software. These codecs provide the access to the 
hardware / software specific translation capabilities of Media Reactor. 
 
Codec Notes 
Final Cut DV NTSC Apple’s Final Cut software. 
Final Cut DV PAL Apple’s Final Cut software. 
Media 100 Macintosh  
Media 100 and Finish NT  
Targa RTX Motion JPEG  
Motion JPEG A Apple’s Motion JPEG A 
Motion JPEG B Apple’s Motion JPEG B 
Avid AVR 1 NuVista 320 X 240 (288PAL) 1 Field 
Avid AVR 12 ABVB 720 X 243 (288PAL) 2 Field 
Avid AVR 1e NuVista 320 X 240 (288PAL) 1 Field 
Avid AVR 2 NuVista 320 X 240 (288PAL) 1 Field 
Avid AVR 25 NuVista 640 X 240 (288PAL) 2 Field 
Avid AVR 26 NuVista 640 X 240 (288PAL) 2 Field 
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Codec Notes 
Avid AVR 27 NuVista 640 X 240 (288PAL) 2 Field 
Avid AVR 2e NuVista 320 X 240 (288PAL) 1 Field 
Avid AVR 2m ABVB 352 X 243 (288PAL) 1 Field 
Avid AVR 2s ABVB 720 X 243 (288PAL) 1 Field 
Avid AVR 3 NuVista 640 X 240 (288PAL) 1 Field 
Avid AVR 3e NuVista 320 X 240 (288PAL) 1 Field 
Avid AVR 3m ABVB 352 X 243 (288PAL) 1 Field 
Avid AVR 3s ABVB 720 X 243 (288PAL) 1 Field 
Avid AVR 4 NuVista 640 X 240 (288PAL) 1 Field 
Avid AVR 4e NuVista 640 X 240 (288PAL) 1 Field 
Avid AVR 4m ABVB 352 X 243 (288PAL) 1 Field 
Avid AVR 4s ABVB 720 X 243 (288PAL) 1 Field 
Avid AVR 5 NuVista 640 X 240 (288PAL) 1 Field 
Avid AVR 5e NuVista 640 X 240 (288PAL) 1 Field 
Avid AVR 5m ABVB 352 X 243 (288PAL) 1 Field 
Avid AVR 6e NuVista 640 X 240 (288PAL) 1 Field 
Avid AVR 6m ABVB 352 X 243 (288PAL) 1 Field 
Avid AVR 6s ABVB 720 X 243 (288PAL) 1 Field 
Avid AVR 70 ABVB 720 X 243 (288PAL) 2 Field 
Avid AVR 71 ABVB 720 X 243 (288PAL) 2 Field 
Avid AVR 75 ABVB 720 X 243 (288PAL) 2 Field 
Avid AVR 77 ABVB 720 X 243 (288PAL) 2 Field 
Avid AVR 8s ABVB 720 X 243 (288PAL) 1 Field 
Avid AVR 9s ABVB 720 X 243 (288PAL) 1 Field 
Avid JFIF 15:1s Meridien 352 X 243 (288PAL) 1 Field 
Avid JFIF 2:1  Meridien 720 X 243 (288PAL) 2 Field 
Avid JFIF 2:1s Meridien 352 X 243 (288PAL) 1 Field 
Avid JFIF 20:1  Meridien 720 X 243 (288PAL) 2 Field 
Avid JFIF 3:1  Meridien 720 X 243 (288PAL) 2 Field 
Avid JFIF 4:1s  Meridien 352 X 243 (288PAL) 1 Field 
 
QuickTime uses software codecs. These modules may come from a number of manufacturers. For 
maximum compatibility, Media Reactor will attempt to use any software codecs that are installed on the 
system.  
 
MediaReactor will also install some software codecs to provide compatibility with hardware that is not in 
your system. These codecs will be available for any other application that can use QuickTime. 
 
The following is a list of codecs that MediaReactor will install. 
 
Codec Notes 
10 Bit Y’CrCb Viewgraphics VideoPump 
8 Bit Y’CrCb Viewgraphics VideoPump 
 
The following is a list of third party codecs that have been tested with Media Reactor. 
 
Codec Notes 
Apple Animation  
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Codec Notes 
Apple BMP  
Apple Cinepak  
Apple Component Video – YUV 422  
Apple DV NTSC   
Apple DV PAL  
Apple Graphics  
Apple H 261  
Apple H 263  
Apple None  
Apple Photo JPEG  
Apple Planar RGB  
Apple PNG  
Apple TGA  
Apple TIFF  
Apple Video  
Intel Indeo Video 4.4  
Sorenson Video ™ Compressor  
 

5.2.4 Audio Files 
 
Media Reactor supports a number of audio file types. It currently just works with PCM audio and does 
not support any compression formats. 
 
File Type Notes 
aiff – Apple – SGI Audio  
au – Sun Audio  
Wav – Window Wave  
Wma – Windows Media  
 

5.2.5 Still Image Files 
 
Media Reactor supports a number of still image file types. 
 
File Type Notes 
bmp - MS Windows Bitmap  
dib - Device Independent Bitmap MS Windows 
icb - TGA Still Image Variant Truevision Image Capture Board  
jpg - JPEG Still Image Joint Photographic Experts Group format 
pbm - Portable Bitmap  
pcx  - Paintbrush Image ZSoft 
pgm - Portable Graymap Format  
pic, pct – Pict Still Image File  
png – Portable Network Graphic  
pnm – Portable Anymap Still Image  
ppm - Portable Pixmap Still Format  
psd – PhotoShop File Adobe PhotoShop 
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File Type Notes 
ras - Sun Micosystems Raster   
rgb Raw RGB image file  
rgba Raw RGB with Alpha  
sgi – SGI Still Image  
sun - SUN Raster image  
tga – Targa Still  Truevision raster graphic 
tiff - Tagged Image Format  
vda - TGA Image variant  
vst - Targa Vista Image Format  
yuv - Raw YUV Image  
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Glossary 
 
2/3 Drop The technique used to convert NTSC (30 frames per second) video generated by a 

Telecine to 24 frames per second (fps) film rate.  A Telecine scans the film frames and 
digitizes them into frames of video.  It must then add generated frames in so that the user 
may view the resulting video at a frame rate of 30 fps.  The 2/3 Drop process removes 
only the frames generated by the Telecine. 

 
 The 2/3 Drop process may also add generated frames of video into a 24 fps video file in 

much the same way as a Telecine. 
 
API Application Programming Interface 
 
Authorization MediaReactor uses a software-based copy protection system, which as part of its 

authentication of user privilege, generates a site code and requires a site key based on that 
site code.  When the proper site key is input, the software will be authorized for use. 

 
Bandwidth This refers to the amount of information that can be passed through a given circuit in a 

given time.  In the case of MediaReactor, the greater the storage bandwidth (the speed at 
which the storage medium can read and write files), the faster the conversion or set of 
conversions can be accomplished. 

 
Bit Depth This refers to the number of bits per pixel that controls the color resolution of the 

translated image. Some file types and codec formats may impose limitations on this 
setting.  

 
CD-ROM Compact Disk Read-Only Memory.  (Also: CD) 
 
Clipboard A temporary file that is created when the user copies a file or information within a file.  If 

the user selects the paste command, anything on the clipboard will be pasted into the 
location selected by the user.  

 
Codec Compression/Decompression format.  For each File Type used in MediaReactor, there is 

an associated list of applicable codec types. 
 
Copy Copy an item to the clipboard.  In Windows, the user may select a line of text using the 

mouse and copy it to the clipboard by pressing (Ctrl+C).   
 
CPU  Central Processing Unit. 
 
Data Rate This refers to the rate of data transfer between systems (especially between data 

generating devices and the attendant storage), expressed in Megabytes per second 
(MB/sec).  A higher data rate will mean that the files you create within MediaReactor 
will be created faster.  A lower data rate will slow conversions, or even make certain 
operations unsustainable. 

 
Direct X This refers to third party software that enhances the functionality of MediaReactor. 
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Edge This field sets an edge value for the de-interlace processing. The edge value controls the 
detection of intra-field artifacts as opposed to actual high frequency content in the image. 
The greater the value of the edge setting the more likely an edge in the image will be 
blended.   

 
Field One half of a complete interlaced video picture containing either all of the odd or all of 

the even scanning lines of a picture. 
 
File Type This refers to the nomenclature for media files having a particular extension and 

conforming to certain file specifications as used in MediaReactor. 
 
Fps   Frames per Second. 
 
Frame A complete interlaced video picture containing two fields, one field with all the even-

numbered lines and one field with all the odd-numbered scanning lines of a picture.   
 
“Free” Mode When MediaReactor is first installed, it is in “free” mode.  In free mode the user may 

access a limited range of supported read and write file types. 
 
GUI Graphical User Interface. 
 
Height This refers to the size of the video image, from top to bottom, in scanning lines.  A line is 

one pixel in height. 
 
Insert Editing operations that do not lay down a new control track.  In digital-based (non-tape-

based) media, this refers to an editing operation that inserts either audio or video into a 
existing file (or a portion of that file), replacing the audio or video present at that 
location. 

 
Installation Guide A tutorial detailing the installation and authorization of MediaReactor software. 
 
Intel Indeo This refers to third party software that enhances the functionality of MediaReactor. 
 
Interlace A process in which the picture is split into two fields, sending all the even numbered lines 

to field one and all of the even numbered lines to field two. 
 
Key Frame This refers to the interval between key frames for the codec of the translated image data. 

Some file types and codec formats will support this setting.  
 
LAN  Local Area Network. 
 
Line One entire horizontal row of pixels. 
 
MS Media Players  This refers to third party software that enhances the functionality of 

MediaReactor. 
 
Paste Enter the item or items on the clipboard into the specified location.  In Windows, the user 

may select a location on the screen using their mouse, and paste the contents of the 
clipboard to that location using (Ctrl+V).  
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Pixel Picture element.  This is a location on the screen having a given color and brightness 
value.  This is also the smallest subdivision of the video image.  For example, an NTSC 
frame of video has a resolution of 640 x 480 pixels. 

 
Quality This refers to the quality factor of the compression scheme of the translated image data. 

Some file types and codec formats will support this setting.  
 
QuickStart The point-by-point tutorial detailing a conversion in brief contained in this manual. 
 
RAM  Random Access Memory. 
 
Reference A section of this manual detailing the interface, the file types supported by MediaReactor 

and containing a glossary of terms used within MediaReactor. 
 
SAN  Storage Area Network. 
 
Session  A set of conversion parameters for a specific type of conversion. 
 
Site Code A sequence of numbers and letters generated by the MediaReactor software-based copy 

protection.  Generate this sequence in the MediaReactor license section and send it to 
Drastic Technologies in order to receive your Site Key, which will license your copy of 
MediaReactor for use. 

 
Site Key A sequence of numbers and letters generated by the MediaReactor software-based copy 

protection.  Enter this sequence into your license dialog box to license your copy of 
MediaReactor for use. 

 
Source  The file the user selects for conversion within MediaReactor. 
 
Standard Video standard.  MediaReactor handles specific file types based on a number of video 

standards but does not perform standards conversions.  MediaReactor will convert video 
files generated by equipment using differing video standards but the video will retain its 
original frame rate. 

 
SVGA Super video graphics adapter. This refers to the hardware adapter for the computer 

monitor.  
 
Target File The file created during the conversion process within MediaReactor. 
 
Target Folder This refers to the folder in which the new file created by the user in the MediaReactor 

conversion process will be located.  This may be set in the Session Window as well as the 
Target Settings window. 

 
Task-based A set of instructions oriented toward achieving a specific task or set of tasks. 
 
Telecine A device that creates video from motion picture film, generating frames of video to 

compensate for the discrepancy between film and “video” frame rates. 
 
Third Party This refers to a product not manufactured by Drastic Technologies which is used as part 

of the integrated product that the customer receives.  The customer is the First Party and 
Drastic Technologies is the Second Party of this business interaction. 
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Threshold This refers to a threshold value for the de-interlace processing. The threshold value 

controls the detection of the intra-field motion of an object. The greater the motion of an 
object between fields the higher the threshold needs to be set so it will be detected and 
used in the blending process.   

 
Transcode An efficient way of copying files which performs certain operations in parallel, realizing 

an increase in processing speed. 
 
User’s Guide A detailed tutorial on the functionality of MediaReactor. 
 
WAN  Wide Area Network. 
 
Width  This refers to the size of the video image, from left to right, in pixels. 
 
Workspace A container for a session or set of sessions.   


